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1. Introduction: 
 

This paper is a collaboration of many people over several weeks.  Hundreds of hours of testing and trials 

have gone into it.  Some things will be obsolete when this ink is dry, so this paper will be a constantly 

evolving aid that can be found online at www.cinemaaudiosociety.org  Check in for updates as they 

happen. 

We would like to extend our thanks to all those who participated.  Especially Scott Wood (Avid technical 

specialist), Robert Kennedy, Jim Machowski, Coffey Sound, Wexler Video and The Cinema Audio Society. 

 

1.1.  Disclaimer:  

 

This document should be used for introduction and industry orientation 

purposes only. It does not represent any specific recommended practice or 

guarantee of success for any specific project. It is provided only to assist 

professionals in orienting themselves to the basic concepts and options 

available for dual recorded video/audio production workflow inside larger film 

and television style projects. Please refer to the original documentation from 

manufacturers and your own testing to determine your specific project 

strategies and workflow choices. 

 

1.2.  Purpose: 
 

Historically, most people went to some kind of “film school,” either in an organized education 

environment by interning in different areas of the industry or through independent study. When these 

historic workflows turned digital, and now advancing toward non-linear workflows, most professional 

kept updated on their individual focus, but many were not introduced to the similar modifications that 

other professional experienced in the other chosen specialties inside film and television production. This 

document is specifically designed to introduce professionals to modern end to end workflow of 

production dialog audio in modern film and television production.  

I’ve also tried to pull out some very important information up front. While some things may function 

properly in one professional operators application, that relative function may not function as people 

may expect in another application, making it unreasonable to depend on some metadata that people 

assume would work for the total end to end production. 

http://www.cinemaaudiosociety.org/
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As there is already a large amount of very detailed documentation from specific manufacturers on each 

application’s independent command for command operation, that is not the goal of this document.   

 

1.3.  Work in progress: 
 

This document is designed to be a work in progress. You will see many areas with very little information, 

as we hope others with more specialization in these areas will contribute their knowledge and proven 

success too. This is not complete and hopefully will continue to expand. 

If/how this information pool expands is up to you. We currently have a commitment from CAS (Cinema 

Audio Society) to host this on their website and to provide a forum for ongoing discussion and growth. It 

may continue. Or it may turn in another direction. Or it may die. It’s up to you and your co-workers to 

decide. 

 

1.4.  How to apply this document: 
 

This document should be used only for introduction and orientation purposes only. It does not represent 

any specific recommended practice or guarantee of success for any specific project. It is provided only to 

assist professionals in orienting themselves to the concepts of modern file based audio production 

inside larger film and television projects. Please refer to the original documentation from manufacturers 

and your own testing to determine your specific project strategies. 

 

1.5.  Exciting things are possible with smart planning, testing, schedule, and 

budget: 
 

More than anything, it’s an exciting new world of workflow opportunities. However, to deliver on these 

opportunities it requires the five basics or any type of project planning: 

1. Smart planning 

2. Testing the plan for both known and unknown issues 

3. Effective scheduling 

4. Budget to support the plan (including labor and equipment) where and when needed. 

5. Community agreement  

Miss on any one of the five and any project strategy can fail. 
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1. 12 Major Workflow Steps: 
 

(Contribution of others to this section is encouraged) 

 

1. Pre-production (Pre-production Design and Testing) 

2. Production (Production Workflow) 

3. Digital Dailies (Media Composer Workflow) 

4. Distribute Production Audio (Distribute Production Audio) 

5. Digital Telecine (Digital Telecine) 

6. Picture Assistant: “3 clip/region proof” (Media Composer Workflow) 

7. Picture Assistant: “3 clip/region proof”  (Export AAF, Copy Audio Files) 

8. Sound Assistant: “3 clip/region proof”  (Pro Tools Workflow) 

9. Picture Assistant: “Main Project” (Media Composer Workflow) 

10. Picture Assistant: “Main Project” (Export AAF, Copy Audio Files) 

11. Sound Assistant: “Main Project” (Pro Tools Workflow) 

 

The 12 major workflow steps represent an overview of a successful production audio file based 

workflow strategy. Note that some appear to be duplicates. The Media Composer workflow appears 

three times, and the Export AAF and Pro Tools Workflow each appear twice. Why is this?  

- The first Media Composer workflow is an option for presenting Digital Dailies in a fast 

turnaround following production. 

- The second set is proof of success testing using a “3 clip/region proof” test. It is the same basic 

Media Composer workflow, but focusing on getting just three clips through the post production 

workflow, through picture editing to audio editing, allowing the key interop staff involved in an 

opportunity to identify what is working, what is not working, and to develope a strategy to 

successfully modify as needed before committing to assembling large amounts of dailies into 

sequences. Often, recognizing and responding by making small adjustments to the workflow 

metadata early in the post process can make dramatic differences in workflow success through 

a large complex project. 

- The third group is the “Main Project” production pipeline. By first applying any metadata 

adjustments identified from information gathered during Digital Dailies and 3 clip proof test, a 

project now has a much better chance of workflow success. 
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 Production Picture Assistant Sound Assistant 

Production  “2 Minute Slate 
Test”  
 

  

Digital Dailies In today’s file 
based workflow, 
it’s getting more 
common to have a 
Media Composer 
laptop on set, 
specifically for 
playing 
picture/sound 
Autosynced 
dailies.  

  

“3 clip/region 
proof” 

 The early test: Identify three 
types of Autosync 
combinations (Example: 
Video tape source, File 
camera w/ integrated 
timecode, DSLR w/ only right 
track timecode?) Autosync as 
needed, and cut three long 
clips to a test sequence, then 
export as AAF for the sound 
assistant to test. 

Load the AAF into Pro Tools, 
open the Project browser to 
see the AAF media’s 
metadata mapping for each 
different result. View the 
related raw production 
polyphonic files using the 
Workspace browser. 
Determine a strategy to 
achieve successful matching. 

Main Project  The main project benefits 
from any knowledge gained 
in the “3 clip” test. When 
loading the massive amount 
of files required on a large 
project, the information 
proven in the “3 clip” test can 
save huge ongoing 
headaches, as metadata can 
be tweaked early enough to 
achieve a predictable and 
consistent workflow. When 
the project has reached the 
stage of picture/sound 
turnover, the assist picture 
editor should have a proven 
strategy for success. 

The main project benefits 
from any knowledge gained 
in the “3 clip” test. When 
loading the massive amount 
of files required on a large 
project, the information 
proven in the “3 clip” test 
can save huge ongoing 
headaches, as metadata can 
be tweaked early enough to 
achieve a predictable and 
consistent workflow. When 
the project has reached the 
stage of picture/sound 
turnover, the assist sound 
editor should have a proven 
strategy for success. 
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2. Pre-Production Design and Testing:  
 

(Contribution of others to this section is encouraged) 

1. Workflow goals: 

a. Screen dailies plan? 

b. Media Composer AutoSync plan? 

c. Pro Tools Expand tracks plan? 

2. Agree on reasonable workflow success 

a. Metadata matching strategy for project goal success 

b. Labor needed to achieve goals (“Who’s going to make the bread.”) 

c. Equipment needed to achieve goals 

3. Test for reasonable workflow success 

A future goal of this section is to develop a pre-production checklist with critical entries for the entire 

production and post-production crew to determine before commencing principal photography.  
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3. Production: 
 

(Contribution of others to this section is encouraged) 

 

1. Check date/time on camera and on cameras and production audio recorder. Are all devices 

using the same local time, Pacific time, or some other shared time zone? 

2. Record each day to a folder named with today’s shoot date 

3. Resolve (i.e. genlock / sync) camera and audio recorder (critical for long takes like filming 

concerts) 

4. LTC to (a) slate, (b) audio recorder, (c) camera LTC in, and (d) record LTC as audio on camera 

channel #2 

5. Record Mix to channel #1 of camera 

6. “Roll sound, Roll camera, Slate, Action, Cut camera, Cut sound” 

7. Record mix on channel #1 of production audio recorder 

8. Set channel names in production audio recorder 

9. Match  “Scene #” in production audio recorder to slate 

10. Match “Take #” in production audio recorder to slate 

 

3.1.  Challenges of dual capture video/ audio acquisition on set: 
 

3.1.1. Speed Resolve: 

Shared speed resolve on set is critical for long recording passes to maintain proper video/audio 

relationships in dual capture productions.  

In shorter drama style production, speed resolving all digital acquisition system will likely not provide as 

dramatic of benefit, and many see it may destabilize digital cameras.  

Each production should make their decision on using a central speed resolve, like black burst or tri-level 

sync, based on their specific production conditions.  

3.1.2. Shared Timecode position: 

Shared timecode position between all production devices offers dramatic benefits for many production 

dailies systems, and nearly all post workflows. However, plugging LTC into the LTC input on cameras can 

also have negative effects for the production.  

 Many feel that plugging LTC into the LTC input on many professional cameras can destabilize 

them.  
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 Many feel having additional devices with cables connected to the cameras complicate 

ergonomics of operating the cameras.  

LTC input strategies for cameras:  

 Many professional cameras have LTC inputs, which translate directly to recorded tape or is 

stamped in metadata on file based recording cameras. 

o Time of day LTC input into tape based cameras can make capturing those tapes (in 

either digital telecine or by the picture assistant) more complex. As there is not enough 

pre and post roll on each take to consistently machine control the deck.  

o On file based cameras, LTC input into the camera, stamping as metadata into the 

recorded file, does not present the same “machine control” challenges for post 

production. This approach can dramatically optimize post production assembly. 

 Most other digital cameras have two or more audio inputs. Many choose to put guide audio mix 

on channel #1, and LTC onto channel #2.  

o Benefits: Very little special knowledge of a specific camera is required. On most, you 

feed the audio streams, set basic levels and the camera records the audio streams.  

o Benefits: Applications like Media Composer have core functionality for LTC recorded on 

audio tracks and applying directly to the clips metadata. 

o Disadvantages: While most post applications can easily mute any audio track 

individually, most public media players on laptops do not. As file based cameras 

continue to gain acceptance, demand for simple desktop playback of newly captured 

files raises in demand too. To mute the audio track containing LTC, yet still hear the 

audio mix guide track, a user must install a player application with that specific 

capability.  Additionally, a minority of devices may exhibit bleed of the caustic sound of 

timecode onto the audio mix record track on camera. 

LTC physical connection options: 

To provide reliable timecode, you must either have: 

 Stable timecode generator on every camera, slate and audio recorder 

OR 

 Hardline feed from a stable source to every camera slate and audio recorder that 

does not have a stable generator 

Getting timecode onto camera: 

1. Lockit / Tri-level Sync box (most reliable, minor inconvenience to most camera ops) 

2. Hardline (extra wrangling effort but inexpensive) 

3. Wireless feeding either TC input (test it first, not all wireless work for this!) or onto audio 

track 

4. Jam camera + walk away (not reliable with all cameras or after battery change) 
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Stable timecode sources include products by: 

o Ambient ACL203 Lockit box 

o Denecke SBT Tri-level Sync Box  

o Evertz 

o Ambient ACC501 Master Controller 

o Denecke GR-1 Master Controller 

 

3.1.3 Considerations when feeding Mix Audio to Camera 

   Wired or wireless:  

 Any audio recording that is critical should be monitored.  If production is relying 

upon the on-camera scratch track for dailies or picture editorial, the 

headphone/output of the camera should be monitored by the sound department.  

Oftentimes this audio goes unmonitored and so it is critical that productions have a 

plan for syncing production audio in time for dailies should a problem arise with the 

Mix track recorded on camera. 

 

Wired: 

 Wired is inexpensive but requires more cable wrangling and may not be an option 

for run and gun scenarios.  Hardwiring does make it easier for a return confidence 

monitor from the camera to the mixer to confirm the audio is patched and usable 

(reducing the likelihood of no one realizing sound isn’t patched after a camera 

position change).  Headphone shortcomings on some cameras limit the utility of this 

confidence monitor. 

 

Wireless: 

 Wireless is convenient but may require additional preparation (to find and set a 

clear RF channel) and may suffer dropouts, especially at the limit of its range.  

Wireless also is prone to running out of batteries (unless it is powered by the 

camera).  There are minor potential issues when powering it with the camera.  Good 

wireless is expensive and may take up valuable clear RF space that could be used for 

talent lavaliers on productions with lots of talent mics.  Any confidence return 

would have to be wireless and thus compromised as a mixer facing compromised 

signal will be unable to determine whether the original feed or the return is 

compromised.   
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Run & Gun Shoots: 

 On run and gun shoots, confidence monitoring of the audio from the camera is 

often the responsibility of the camera operator when the mix is sent wirelessly.  

When hard-lined, the sound mixer uses a beta-snake that offers send and a return 

for confidence monitoring.   

 

3.1.4 Shared metadata information: 

All metadata acquired during production comes from somewhere. The most valuable information is the 

most easy to create consistently: 

 Every morning, check date and time on all digital camera and audio systems. Post 

production’s most basic matching is “shoot date.” Agree on set if you are using local 

time, Pacific time, or another chosen time zone for today’s production. It’s critical to 

assure all production devices “roll over” to the next day at nearly the same time to 

make locating and syncing picture and sound assets in post.  

 Tape names, which on many production devices, are derived from the folder name 

that the files are recorded into. Matching tape name strategies can streamline post 

assembly and matching of video and audio takes.  

 Audio channel names entered on production audio recorders are a benefit to both 

the picture and sound editors. Both Media Composer and Pro Tools have specific 

workflow enhancements to benefit post. Even if basic audio channel information is 

entered that can be used for most all the production day, it’s a big benefit. For 

example: “Mix”, “Boom”, “Lav 1”, “Lav 2”, “Lav 3”, etc. is far better for picture and 

sound post than just 1,2,3,4,5,6,7,8, etc. 

 Scene and Take are a big benefit in post production as it is the primary method to 

see where and how many alternate takes can be found. Even updating the scene 

number each time production changes scene provides large benefits, even if takes 

are only updated as possible during a busy production environment.   

 

3.1.4 Audio Monitoring: 

 Any device recording audio can benefit from having a trained professional monitoring that audio 

output of that device. Many cameras and other recorders have a large range of amplitude 

headroom. Feeding the same signal to all devices at the same level is no guarantee a usable 

audio recording will result. 
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3.2 Setting Up Before Shooting (Video and Fully Non-Linear Workflows): 
Before shooting begins, the camera operator and the production sound mixer should ensure the 
following: 
 
• The field recorder’s audio output feeds the video camera’s audio input. 
• Both the field recorder and the video camera should be using the same production timecode. 

 
 
 

3.2.3 Matching Linear Tape Name to Sound recording folder name:  
Before loading the videotape into the video camera, the camera operator physically labels the videotape 
with a unique name. If production sound mixer uses that for their recording folder name, most devices will 
transfer that information into the ―Tape‖ BEXT or iXML metadata field inside the Broadcast WAV file, it 
can streamline post production matching. 

 

3.2.4 Match Non-Linear Camera “Tape” to Sound “Tape” Metadata Field: 

 
After loading the digital video storage into the camera, the camera operator gives it a unique folder name, 
which is often translated into the ―tape‖ metadata column. If production sound mixer uses that same exact 
folder name in their production audio recorder, if too can be translated into the ―Tape‖ metadata entry in 
the BWF BEXT or iXML metadata field inside the Broadcast WAV file. This shared text can greatly 
streamline post production video/audio matching. 
 
Many people choose to include the date in the folder name, which makes it easy for the post people to 
match folders of video and audio files that were shot on the same day. 
 
 
 
 

3.3 Production Workflow: 

 
Notes: 

 Autosync in Media Composer works best when the timestamped production audio files start 

before picture file starts, and audio files ends after picture recordings end. This gives enough 

head room to enable audio “pref slipping” the video/audio relationship in Media Composer, to 

easily adjust for any production timecode anomalies. Many audio recording devices have a “pre-

record” feature that provides a pre-take handle in the file, even if the record button is hit later 

in the production cycle. 

 The production sound mixer has designated one or two channels as a production sound mix, 

which is a consolidation of one or more channels in each multichannel recording. Most post 

professionals prefer the audio mix on channel #1 of all recording equipment. 

 During shooting, the following time code information is captured: 

o Film devices record keycode style metadata 

o Video devices record SMPTE time code, either in their integrated timecode, or on an 

audio track 
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o Production audio recorders record synced to SMPTE time code. 

 The slate operator claps the slate to indicate the beginning of the take. The field recorder 

records the audio of the clap, and each camera captures the following images, which will later 

be converted to digital metadata: 

o Scene and take number (displayed on the slate) 

o Frame where the slate closes 

o Time code position of the slate closing 

o Date of the slate closing  



 

15 
 

4 Screening Digital Dailies: 
 

(Contribution of others to this section is encouraged) 

 

There are many options available for distributing early production video/audio dailies, depending 

on the speed, quality, and location of the target audience of those dailies. 

 

Sharing tight synchronization and shared metadata can speed video/audio matching to hit early 

screening deadlines. 
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5 Distribute Production Audio to Post: 
 

(Contribution of others to this section is encouraged) 

 

Distribute daily audio recording folders with sound reports to telecine, Picture Assistant and Sound 

Assistant. 

After the production sound mixer delivers production source file recordings, the raw files should be 
distributed to all three post production groups that need access to the raw audio files: 
 

 Telecine operator 

 Avid Media Composer picture editor assistant 

 Pro Tools audio editor assistant 
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6 Digital Telecine: 
 

(Contribution of others to this section is encouraged. Help!!) 

 

1. Camera “tape and timecode” + production audio “tape and timecode” = Telecine “tape and 

timecode”  

2. Record to telecine tape 

3. Export bin/ALE/FLEx/etc 

 

Warning:  

Media Composer telecine FLEx/ALE style “sync’ed dailies” workflow is dependent on sound roll 

metadata. Media Composer currently only supports 29.97 sound roll metadata in that sound roll 

metadata field. Media Composer does not work with 23.976, 24 or 25 fps in the Media Composer sound 

roll metadata column.  

6.1 Telecine Transfer (Film Workflow) 
When shooting is complete for the day, the following components may be delivered to the telecine 
operator: 
 

 Processed film stock 

 Production video tapes 

 Production video files 

 Multichannel location audio 

 Written production shoot list  

 Written production sound log 
 
The telecine operator combines these production assets to generate the dailies (a videotape containing 
the day’s shots) by transferring the images and audio to a videotape, and exporting a FLEx style log 
describing the way the production assets were combined to create each telecine dailies tape. The 
shootlists and production sound logs may be used as a guide information. 
 
To use a telecine to create dailies: 
 
1 Load picture and audio into the telecine equipment. 
 
2 Enter the picture asset specific name, metadata and Sound Roll name and metadata (whichever was 
used during the production) character for character into the telecine.  
 
To ensure that metadata are preserved for success in post metadata workflows, it is critical to enter the 
Tape name or Sound Roll name character for character. For example, if the metadata was T001 (with two 
zeroes), enter T001 with two zeroes—not T01 with one zero or T0001 with three zeroes or Tape001. 
 
3 Using the camera assistant’s shootlist, locate the film frame representing the first keycode position of the 
film in the shootlist (which should be just before the slate is clapped). 
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4 Locate the picture to the first frame where the slate clap occurs and note the time code position displayed 
on the slate. 
 
5 Locate the audio to the exact time code position listed on the slate in the film frame (which lines up the 
audio with the film). 
 
6 Play back the film and audio to test that they are synchronized. If they are not synchronized, 
make small manual adjustments as needed until the film and audio are synchronized. 
 
7 Once the film and audio are properly synchronized, lock the film and audio in place. 
 
8 Insert a blank videotape into the VTR connected to the telecine, and manually assign linear 
time code (LTC) information to the videotape. 
 
9 Begin the telecine capture. During the telecine capture, the following occurs: 
• The telecine begins capturing the synchronized film and audio to the videotape, with 
linear time code (LTC) being assigned to the videotape beginning from where you entered the start time 
code. 
• A FLEx type file is created, where scene and take information is automatically written and 
associated to the film keycode and telecine videotape time code relative to audio time code. 
 

10 When the telecine transfer is complete, deliver the following to the Avid editor: 
• Telecine videotape 
• FLEx file 
• Shootlist 
• Sound log 
• Location audio media 
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7 Media Composer Workflow: 
(Contribution of others to this section is encouraged) 

 

1. Set proper audio settings: Sample Rate, Bit Rate, SRC 

2. Load any bin/ALE/FLEx/etc if available 

3. Load picture 

4. Check picture metadata 

5. - Load production audio if desired  

a. - Check audio metadata 

b. - Autosync Dailies (3 ways) 

6. Edit sequences (Or AutoSequence for Digital Dailies) 

7. Export sequences as AAFs 

 

7.1 Loading production assets: 
Modern production assets fall into three basic categories.  

 Telecine style workflow 

 Raw video tape workflow 

 Video file based workflow 

Each should be loaded into Media Composer in it’s own way.  

 

7.2 Batch Digitizing the Telecine Videotapes to Digital Files:  
This phase of the workflow begins after the picture assistant editor receives the following components 
from the telecine operator: 
 
• Telecine videotape 
• FLEx file 
• Shootlist 
• Sound log 
 

In a film workflow, the picture editor batch digitizes the telecine videotape to digital video and audio 

files in preparation for editing the show. To batch digitize a telecine videotape to digital source files: 

1. In the Avid application, import all relevant FLEx files into Avid Log Exchange. Avid Log Exchange 

displays a list of all scene and take combinations, with associated film keycode, audio time code, 

and relative videotape time code. 

2. In Avid Log Exchange, select the items in the FLEx file that represent the scenes and takes you 

want to batch digitize from the videotape. 

3. Process the selected scenes and takes in the FLEx file. Avid Log Exchange sends the selected 

items to the Avid application, where they are loaded into the Bin as offline media. 
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4. In the Avid Bin, select the items you want to capture. 

5. Load the telecine videotape into the Avid, and begin the batch digitize. The Media Composer 

can automatically batch digitizes the scenes and takes selected in the Avid Bin, and uses the FLEx 

file to assign each of the digitized video and audio files with the time code information matching 

the original keycode and time code information from the shoot. 

6. When the batch digitize is complete, use the Avid application to edit audio and video. 

7. When you are finished editing, export the edited sequence as an AAF or OMF sequence so that 

it can be imported into Pro Tools. 

 

7.3 Digitizing Raw Production Videotape in the Avid Application: 
 
(Video Workflow Only) 
This phase of the workflow begins after the Avid editor receives the following production assets from the 
camera operator and the production sound mixer: 
• Videotape 
• Multichannel recordings 
 
In a video workflow, the Avid editor digitizes the videotape to digital video and audio files in order 

to edit them. While doing so, the Avid editor is prompted to enter the name of the source tape. 

To digitize a videotape to digital source files: 

1. Load the videotape into the Avid system. 

2. When prompted to name the videotape, enter the exact Tape name used by the camera 

operator and the production sound mixer. 

3. Digitize the videotape loaded into Media Composer. 

4. When the digitizing is complete, edit the audio and video. 

When you are finished editing, export the edited sequence as an AAF or OMF sequence. Open or import 

into Pro Tools. 

 
 

7.4 Importing Digital Video Directly into the Avid Application: 
(Fully Non-Linear Workflow Only) 
 
This phase of the workflow begins after the Avid editor receives the following components from the 
camera operator and the production sound mixer: 
 

• Digital video (on flash card, hard drive, or some other file-based storage) 

• Multichannel recordings 
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In a fully non-linear workflow, the Avid editor simply has to import the video and audio media into the Avid 
application in order to edit them. 
 
To import video into the Avid application: 
 

1. In the Avid application, create a Bin. 
 

2. Import the video files directly into the Bin. 
 

3. When the Disk Label Import dialog appears, enter the exact Tape name used by the camera 
operator and the production sound mixer. 

 
4. Use the Avid application to edit audio and video. 

 
5. When you are finished editing, export the edited sequence as an AAF or OMF sequence so that it 

can be imported into Pro Tools. 

 

7.5 Working with BWF Files: 
 

Media Composer supports any BWF files that adhere to the BWF specification. 

The following information from BWF information always appears in bin columns. 

 

 

Bin 

Column 

BWF Source 

 

Clip Name Imported File Name. If scene and take information is provided, the clip name is 

created as scene/take 

Tape ID Imported file name 

Start The start timecode specified in the file 

Shoot Date The original date specified in the file 

Tape Name If there is not tape name specified in the file, a name is created by concatenating 

the origination date and the imported file name 

 

  

You can use Media Composer-specific coding to ingest additional metadata information from the 

comments section in the BEXT header of BWF files. Currently, the following vendors have 

products that can provide additional information: 

 Aaton 

 Fostex 

 Nagra 

 Sonosax 

 Sound Devices 

 Tascam 

 Zaxcom 

(These are the production audio recorders noted in the Media Composer documentation. Other 

production audio recorders that deliver the same BEXT style may deliver comparable results.) 
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Avid editing applications support 24-bit audio data, and up to 16 tracks in a single file. You can 

use the AutoSync feature to sync these tracks. You can also use AutoSync to sync picture and 

sound. 

 

7.6 What is AutoSync? 
When you capture footage in that includes both audio and video, Media Composer automatically 

establishes sync when it creates clips in the bin.  “AutoSync” applies to audio and video clips 

that you capture or import separately, usually from two separate recording sources. Autosyncing 

creates a new subclip that displays sync breaks in the Timeline as though the audio and video 

were captured simultaneously. 

 

7.6.3 Understanding Autosyncing: 

Autosyncing is often used for projects in which picture and sound were captured separately. These clips 

are often synced based on common film timecode, sound timecode, or auxiliary timecode.  

You can also AutoSync any audio and video clips based on a user-defined In point or Out point 

relationship that you establish with marks. For example, you can use the slate as a common visual and 

audio reference for Autosyncing the clips. 

Use the following guidelines when Autosyncing: 

You can AutoSync audio clips with video clips only. To link two or more video clips or audio clips into the 

same multi-clip, use the Media Composer Grouping feature. 

If the audio and video clips do not have matching source or auxiliary timecode, you must establish 

common sync frames. To do this, mark In points (or Out points) on both clips before you AutoSync. You 

can create only one Autosyncing subclip at a time when syncing with the clip mark in or mark out points. 

You cannot AutoSync numerous pairs of audio and video clips simultaneously using mark in or mark out 

points. When you AutoSync using this method, the whole clip is taken into the subclip. 

If you AutoSync clips of different lengths, the longer clip is truncated to the length of the shorter clip; 

video clips override audio clips. 

If you AutoSync according to common timecodes that are staggered (one clip starts later than the 

other), the later starting timecode becomes the start of the new subclip. The clip with the earlier 

starting timecode is trimmed accordingly. 

 

7.6.4 Creating an Autosynced Subclip: 
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To create an Autosynced subclip: 

1. Highlight two or more clips in the bin. 

2. Select Bin > AutoSync. 

3. Select an option, based on the following grid: 

4. Click OK 

Film TC/Sound 

TC 

Use this option if you sync clips with matching film and 

sound timecode recorded in the field. This option appears 

dimmed if you are not in a 24p or 25p project. 

 

24p &25p 

only 

Inpoints Use this option if you sync two clips at a time according to 

In points set in both clips. 

 

V & A clip 

with mark 

ins 

Outpoints Use this option if you sync two clips at a time according to 

Out points set in both clips. 

 

V & A clip 

with mark 

ins 

Source Timecode Use this option if the two clips have matching timecode or to 

AutoSync multiple clips, use the Start timecode. The default 

option. 

 

Multiples 

Auxiliary TC1–

TC5 

Use this option if the two clips have matching timecode in 

the same Auxiliary Timecode column or to AutoSync 

multiple clips, use the Aux 1-5 timecode. Select an Aux TC, 

1 through 5, from the menu. 

 

Multiples 

Keep audio on 

clip with video 

Use this option if you want to keep the selected video clip’s 

audio tracks. Specify which audio tracks you want to keep 

from the Start and End range. All audio tracks within this 

range will be kept. (Off by default.) 

 

 

Include audio 

from audio-only 

clips 

Use this option to keep the selected audio tracks with the 

audio-only clip. Specify which audio tracks you want to keep 

from the Start and End range. All audio tracks within this 

range will be kept. (Off by default.) 

 

 

Collapse Audio 

Tracks 

Use this option to remove any unused audio tracks and then 

move the audio tracks to the next available tracks. For 

example, if you have 8 audio tracks but tracks A2, A4, A6 

and A8 did not have audio. If you select this option, tracks 

A2, A4, A6 and A8 would be removed and A1, A3, A5 and 

A7 would move into the A1 through A4 tracks. Off by 

default. 
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The subclip is created and named by default after the video clip with the file name extension 

.sync.n, where n is the incremental number of subclips created with the same name. 

 

You can change the name according to preference. You can load an Autosynced subclip into the 

Source monitor and immediately edit it into a sequence. 

 

.  

7.6.5 Resyncing Audio for a Selected Subclip: 

 

In Media Composer projects created with the “Film” option checked, for example in a 35mm 4 

perf project type, you can "perf slip" the audio in the subclip up to a 1/4 frame in either direction 

for even tighter sync 

 

To resync audio for a selected subclip: 

1. Load the subclip into the Source monitor. 
2. Change the Media Composer view setting to see the content of the source monitor in the 

timeline window. 
3. Select the location of the slate close in the audio timeline 
4. Open the Tools> Command Pallet and open the Trim tab. Enable “Active Pallet” setting.  
5. Advance audio in the timeline by “perfs” (1/4 frame in 35mm 4 perf mode) by hitting the Slip 

Left 1 Perf command. Each click of the perf button performs the sync adjustment. 
6. Delay audio in the timeline by “perfs” (1/4 frame in 35mm 4 perf mode) by hitting the Slip Right 

1 Perf command. Each click of the perf button performs the sync adjustment. 
7. Play the subclip in the Source monitor to evaluate your sync adjustment. Repeat the previous 

steps to further adjust the sync.  
8. Choose to view “slip” in bin column header to see the amount of slip on each synced subclip 

adjusted. 
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8 Export AAF, Copy Audio Files: 
 

(Contribution of others to this section is encouraged) 

 

1. Export audio as AAF 

2. Copy Audio Files Folder 

3. Use Same Folder as AAF file 
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9 Pro Tools Workflow: 
 

(Contribution of others to this section is encouraged) 

 

1. Set proper audio settings: Sample Rate, Bit rate, frame rate 

2. Import AAF 

3. Open Project Browser>Audio Folder 

4. Open Workspace Browser>(Production audio polys folder) 

5. Adapt Production Poly’s metadata to align with Project Browser metadata 

6. Drag and Drop polys to Region list. (Wait for polys to split to mono files.) 

7. Condense timeline tracks where possible.  

8. Hide tracks that don’t need expansion 

9. Right click on track name, select Expand Tracks method 

10. Condense expanded tracks 

11. Remove unused audio if desired 

 

 

9.1 Supported Field Recorder Audio Files and Metadata: 
Pro Tools supports the following audio files recorded by production audio recorders: 
 
• OMF-wrapped media 
• MXF 
• Broadcast WAV (BWF) files with the following metadata: 

• Both BEXT and iXML chunks 
• BEXT metadata but no iXML metadata 

 

9.1.3 Caveats: 
The following caveats apply to handling of imported metadata from field recorders. 
 

 The BEXT specification as described here adds some features that conform to standards used by 
Avid applications and Pro Tools—specifically, Description metadata is interpreted differently. 

 When you import multiple files in which the same metadata are populated with different values, 
Pro Tools imports the value that is first present based on the following order: 

 Avid OMF-wrapped media or MXF media 

 Any iXML chunk metadata in a BWF 

 Any BEXT chunk metadata in a BWF 

Note: Audio Suite processing creates new rendered audio files. Those rendered Audio Suite results do 
not have the production metadata for use in expand tracks workflows. 
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9.2 Pro Tools DigiBase Support for Field Recorder Metadata: 
DigiBase browsers display the following metadata from multichannel recordings made with field 
recorders: 
 
• Duration 
• File Comment 
• Date Modified 
• Date Created 
• # Channels 
• Format 
• Sample Rate 
• Bit-Depth 
• Original Time Stamp 
• User Time Stamp 
• Tape 
• TC Rate (renamed from FPS) 
• Channel Names 
• Scene 
• Take 
• Shoot Date 
• Sound Roll 
• Sound Roll TC 
• Sound Roll TC Rate 
• User Bits 
• Tape ID 
• Project 
• Circled 
• Clip Name 

 

9.3 About Tape and Sound Roll Metadata: 
Avid application and field recorders use Tape to represent different kinds of metadata: Avid uses 
Tape to store the telecine videotape name, while a BWF file with a BEXT chunk or iXML chunk 
uses Tape to store the name of the sound roll. To avoid this overlap, Pro Tools preserves Tape 
metadata from the Avid and populates Sound Roll with Tape metadata from BWF audio files. 
 

9.4 About Shoot Date Metadata: 
Many field recorders do not populate the Shoot Date field, relying instead on the file's Creation 
Date to indicate date of production. When Pro Tools imports a field recorder file, it checks 
to see if the Shoot Date field is populated. If it is empty, Pro Tools copies the Creation Date of the 
original file to the Shoot Date field of the new files. 
 

9.5 Editing the Channel Name: 
The Channel Name field in DigiBase displays the channel name, followed the by channel 
number in parentheses. When using Pro Tools 8 or higher, it is possible to edit the channel 
name for mono BWF files. When editing the channel name, anything you enter in parentheses 
will be discarded. However, the channel number will always be preserved. 

 

9.6 Importing an AAF or OMF Sequence into Pro Tools: 
To open an AAF (or OMF) sequence as a Pro Tools session: 
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1. Launch Pro Tools. 
 

2. Choose File > Open Session. 
 

3. In the Open Session dialog, navigate to the AAF or OMF sequence you want to import. 
 

4. Click Open. 
 

5. Name your session in the File Name field. 

 

6. Select WAV from the Audio File Type pop-up menu. 

 
7. Select the I/O Settings to use for the session. Several pre-configured I/O Settings are included 

with your system, or you can select a custom I/O Setting that you have created. 
 

8. Click Save. 
 

9. The Import Session Data dialog appears. 
 

10. Choose Link to Source Media (Where Possible) from the Audio Media Options pop-up menu. 
 

11. In the Source Tracks section, select tracks to import by clicking the pop-up menu to the right of 
each track name and selecting Import As New Track. 
 

a. (Any tracks that were selected in the Avid Timeline when the sequence was exported 
appear in each pop-up menu.) 

 

12. Change any other parameters as needed. 
 

13. Click OK. 
 
Pro Tools creates a new Audio Files folder, Fade Files folder, Video Files folder, cache.wfm file, and 
session file at the designated locations.  
 
This session matches the audio file type, sample rate, and bit depth of the audio in the selected AAF or 
OMF.  
 
Any selected tracks in the Source Tracks section of the Import Session Data dialog are automatically 
placed in the Timeline.  
 
Any autosynced alternate source audio that was exported from the Avid Bin with the AAF or OMF 
appears in the Region List. 
 

 

9.7 Audio Files from Media Composer are not candidates for Expand Tracks 

matching. 
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If alternate source audio files were located only in the Avid Bin (and auto-synced to the location audio mix 
on the Timeline) when exported from the Media Composer application, they will not be available for 
Expand Tracks matching. However, they will be imported directly into the Region List. 

 

9.8 Importing Alternate Source Audio Directly into Pro Tools: 
 
You can import monophonic or polyphonic audio files from field recorders into Pro Tools using 
either of the following methods: 
 

 Using File > Import > Audio, and selecting the files you want to import 

 Dragging files to the Region List from DigiBase browsers or the desktop (and then using the 
Audio Import Options dialog to place them in the Region List) 

 
 

9.9 Repairing Audio Misalignment: 
When you use Pro Tools to import alternate source audio that came through video editing applications, 
that audio may be offset with the audio in the AAF or OMF sequence. This misalignment results from the 
incompatibility between frame-accurate time stamping in video applications and sample-accurate time 
stamping in BWF audio files created in production audio recorders or Pro Tools.  
 
In order to repair this discrepancy, you can offset the alternate source audio after importing it into Pro 
Tools, either manually, or with a utility like SynchroArts Titan. 

 

9.10 Displaying Field Recorder Metadata in Pro Tools: 
 
You can enable or disable the display of field recorder metadata within regions in the Timeline 
and the Region List. 
 
To enable or disable the display of field recorder metadata in playlists: Do the following: 
 
 From View > Region, select or deselect either of the following options: 

 Channel Name 

 Scene and Take 
 
To show or hide field recorder metadata in the Region List: 

1. Click the Region List pop-up menu, and choose Show. 
2. From the Show submenu, select or deselect either of the following options: 

a. Channel Name 
b. Scene and Take 

 
When enabled in the Region List, Scene and Take metadata are added to every region when available in 
the corresponding audio file. 

 

9.11 Displaying Production Audio in the Region List: 
 
When importing multichannel recordings from a field recorder, Pro Tools saves each channel as a 
separate region. Regions from the same multichannel recording are collected into a multichannel region, 
which displays as a single item in the Region List.  
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An expand/collapse triangle next to an item in the Region List indicates a multichannel region. 
 
For multichannel audio regions imported from field recorders to be shown as collective regions, both 
component regions must have the following properties: 
 

 Same length 

 Same region name prefix (such as Audio File or Audio File_01) 

 Consecutively-numbered region name suffix from A1 through A8 
 
For example, the regions Audio File_01.A1 and Audio File_01.A2 would be grouped as a multichannel 
region in the Region List. If an existing stereo or multichannel region has been dragged onto multiple 
mono tracks and edited in such a way that one or more components are no longer the same length, the 
stereo display is removed and the regions are displayed as individual regions in the Region List. 

 

9.12 Conditions for Alternate Channel Availability: 
 
An alternate channel is available to replace the original channel (represented by the region or portion of a 
region selected on the Timeline) if all of the following are true: 
 

 Both channels are part of a multichannel part of a recording made simultaneously on one or more 
field recorders. 

 Certain metadata matches between the original channel and the alternate channel. 

 The metadata embedded during shooting and recording has been preserved prior to import into 
Pro Tools. 

 
With multichannel recordings from one or more field recorders, both channels must overlap at least once 
between their start time code and end time code positions, and must also meet one of the following 
conditions: 
 

 Matching Scene and Take 

 Matching Shoot Date (applies only if Scene and Take contain any information for both channels) 

 Matching Tape name 

 Matching Sound Roll name 

 Alternate channel Sound Roll name matches current channel Tape name 

 Alternate channel Tape name matches current channel Sound Roll name 

 

9.13 Expanding Alternate Channels to New Tracks: 
(Pro Tools HD and Pro Tools with Complete Production Toolkit 2 Only) 
When working with a mono region that is part of a multichannel recording, you can expand that region (or 
a selected portion of it) to new tracks that reflect its matching alternate channels while preserving any 
edits or fades. 
 
For example, this feature lets you easily create different versions of an edited dialogue track 
corresponding to multiple channel inputs (microphones) that were recorded simultaneously. 
 
If the production sound mixer entered the channel name (or some other descriptive reference) 
during shooting, the Matches pop-up menu displays this information. 
 
To expand alternate channels to new tracks: 
 

1- In the Timeline, do one of the following: 
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a. To expand only a portion of the regions on the track, make a selection that includes or 
overlaps any number of regions on a track, and Control-click (Mac) or Right-click (Mac or 
Windows) the selection. 
– or – 

b. To expand all of the regions on the track, Control-click (Mac) or Right-click (Mac or 
Windows) the track name. 
 

2- Choose the Expand Channels to New Tracks submenu, and select one of the following methods 
by which to expand alternate channels for the selection to new tracks: 

 

 By Channel Name 

 By Channel Number 

 By Channel Name and Number 

 By Time Code Only 
 
If alternate channels are available, Pro Tools expands them (plus the channel represented in the original 
track) to new tracks, according to the chosen parameters. 
 

9.14 Determining Method of Expanding Alternate Channels to New 

Tracks: 
 
Alternate channels may be expanded to new tracks by channel name, channel number, channel name 
and number, or time code only. 

 

9.15 Expanding Alternate Channels by Channel Name: 
 
Choosing Expand Channels to New Tracks > By Channel Name creates a new track for each unique 
channel name (such as Boom) found in alternate channels of the selection.  
 

9.16 Result of expanding a selection to new tracks: 
 
If duplicate channel names are encountered, additional tracks are created for each duplicate channel 
name, as follows: 
 

 If the duplicate channel has a different Sound Roll or Tape name from another channel with the 
same channel name, an additional track is created for that duplicate channel and its Sound Roll 
or Tape name is appended to the track name.  

 If the duplicate channel has the same Sound Roll or Tape name as another channel with the 
same channel name, only the topmost duplicate channel in that list of alternate matching 
channels will be expanded to a new track. 

 
Each new track contains only channels sharing a particular channel name, with edits and fades preserved 
from the original selection. Gaps reflect regions from the original selection that did not have an alternate 
matching channel with that channel name. 

 

9.17 How Tracks Are Named When Expanding Alternate Channels by Channel 

Name: 
 
Tracks expanded this way are named as follows: 
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 For unique channel names that create only one track, each track is named using the original 
track’s name plus the channel name. For example, expanding the unique channel name Boom 
from the track Guide.A1 would create a new track called Guide.A1.Boom. 

 For unique channel names that create two or more tracks, each of the new tracks that share 
channel names are named by appending SR (for Sound Roll) plus the number of the sound roll or 
tape to the new track name. For example, expanding the duplicate channel names Boom from the 
track Guide.A1 would create Guide.A1.Boom.SR:100 and Guide.A1.Boom.SR:101, where 100 
and 101 represent the Sound Roll or Tape name. 

 

9.18 Expanding Alternate Channels by Channel Number: 

 
Choosing Expand Channels to New Tracks > By Channel Number creates a new track for each unique 
channel number (such as A1) found in the list of combined matching alternate channels for all regions in 
the selection. 
 
If duplicate channel numbers are encountered, additional tracks are created for each duplicate 
channel number, as follows: 
 

 If the duplicate channel has a different SoundRoll or Tape name from another channel with the 
same channel number, an additional track is created for that duplicate channel and its Sound Roll 
or Tape name is appended to the track name. 

 
Expanded channels with gaps representing regions that did not have an alternate matching channel with the 
channel name. 
 
 

 If the duplicate channel has the same Sound Roll or Tape name as another channel with the 
same channel number, only the topmost duplicate channel in that list of alternate matching 
channels will be expanded to a new track. 

 
Each new track contains only channels sharing a particular channel number, with edits and fades 
preserved from the original selection. Gaps reflect regions from the original selection that did not have an 
alternate matching channel with that channel number. 

 

9.19 How Tracks Are Named When Expanding Alternate Channels by Channel 

Number: 

 
Tracks expanded this way are named as follows: 
 

 For unique channel numbers that create only one track, each track is named using the original 
track’s name plus the channel number. 

 
For example, expanding the unique channel number A1 from the track Guide.A1 would create a new 
track called Guide.A1.A1. 
 

 For unique channel number that create two or more tracks, each of the new tracks that share 
channel numbers are named by appending SR (for Sound Roll) plus the number of the sound roll 
or tape to the new track name. For example: Expanding the duplicate channel number A1 from 
the track Guide.A1 would create Guide.A1.A1.SR:100 and Guide.A1.A1.SR:101, where 100 and 
101 represent the Sound Roll or Tape name. 
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9.20 Expanding Alternate Channels by Channel Name and Number: 
 

Choosing Expand Channels to New Tracks > By Name and Number creates a new track for each unique 
channel name and number (such as Boom.A1) found in the list of combined matching alternate channels 
for all regions in the selection. If duplicate channel names and numbers are encountered, additional 
tracks are created for each duplicate channel name and number, as follows: 
 

 If the duplicate channel has a different Sound Roll or Tape name as another channel with the 
same channel name and number, an additional track is created for that duplicate channel and its 
Sound Roll or Tape name is appended to the track name. 

 If the duplicate channel has the same Sound Roll or Tape name from another channel with the 
same channel name and number, only the topmost duplicate channel in that list of alternate 
matching channels will be expanded to a new track. 

 
Expanded channels with gaps representing regions that did not have an alternate matching channel with the 
channel number 

 
Each new track contains only channels sharing a particular channel name and number, with edits 
and fades preserved from the original selection. Gaps reflect regions from the original selection that did 
not have an alternate matching channel with the channel name and number. 

 
How Tracks Are Named When Expanding Alternate Channels by Channel Name & Number 
 
Tracks expanded this way are named as follows: 
 

 For unique channel name and number combinations that create only one track, each track is 
named using the original track’s name plus the channel name and number. For example, 
expanding the unique channel name and number combination Boom.A1 from the track Guide.A1 
would create a new track called Guide.A1.Boom.A1. 

 For unique channel name and number combinations that create two or more tracks, each of the 
new tracks that share channel name and numbers are named by appending SR (for Sound Roll) 
plus the number of the sound roll or tape to the new track name. For example, expanding the 
duplicate channel name and numbers Boom.A1 from the track Guide.A1 would create 
Guide.A1.A1.SR:100 and Guide.A1.A1.SR:101, where 100 and 101 represent the Sound Roll or 
Tape name. 

 

9.21 Selecting an Alternate Channel to Replace a Region: 
 
Once you have imported an AAF or OMF sequence into the Timeline and alternate source audio into the 
Region List, you can replace the original production sound mix with an equivalent alternate channel while 
preserving the original edits. 
 

9.22 Replacing a Region with a Matching Segment from an Alternate Channel: 
 
You can replace a mono region (or selected portion of a mono region) with a matching segment 
of an alternate channel that was recorded simultaneously. Any fades performed on the original region are 
automatically recalculated against the replacement region, and any pre-existing automation on that track 
is unchanged.  
 
 
To replace a region with a matching alternate channel: 
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1. In the Timeline, make a selection that includes or overlaps the region or portion of the region you 
want to replace. 

 
a. If the Import Session Data process imported all alternate source audio directly into the 

Timeline, this procedure is unnecessary. 
 

b. Using this feature is especially useful when combining it with duplicating the production 
sound mix track. For example, you could replace the audio from a boom microphone with 
the audio from a lavalier microphone, while preserving any edits or fades from the original 
edited production sound mix in the AAF or OMF sequence. 

 

2. Do one of the following: 
a. With any Edit tool, Right-click the selection you want to replace, then select Matches from 

the pop-up menu. 
– or – 

b. With the Selector tool, Command-click (Mac) or Control-click (Windows) the selection you 
want to replace. 

 
3. From the Matches pop-up menu, select the name of the alternate region that you want to use to 

replace the original region. 
 

4. Repeat this procedure for every region you want to replace on each track. 

 
 
 

9.23 Expand To New Tracks By Time Code Only (Event Repurposing): 
 

―Expand To New Tracks By Time Code Only‖ command is specifically for ―event repurposing‖ workflows, 
such as post produced concerts or stage events. This is used when expanding the video editor’s AAF 
audio tracks to expand to matching tracks with the entire original multi-track source audio that was 
recorded during the event while referenced to time code, but where channel names or numbers were not 
written to the audio files. 
 
Advantage:  
This workflow does not require any specific production metadata other than timestamped BWF audio 
files.  
 
Disadvantage:  
This workflow only works for events that were recorded within a single 24 hour timecode duration, like 
concerts or stage events. Even if other production metadata is present, this workflow only uses the 
generic BWF timecode timestamp, and no other production metadata.  
 
This makes it perfect for repurposing events recorded as BWF files in most professional workstations, like 
Pro Tools. 
 
This workflow adds ability to expand an entire track or only selected regions to new playlists on the same 
track or to new separate tracks, thus revealing all other tracks recorded at the same timecode location 
during the event, ignoring all channel name or number metadata.  
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9.23.3 Example Workflow: For Event Repurposing: 
For live concert videos, the video is captured separately while the audio is recorded in Pro Tools. The 
video editor will use a guide audio track that is edited along with the video in their video editing software 
(such as Avid Media Composer). The edited guide track is then returned to Pro Tools, but it needs to be 
expanded to the conformed original source tracks for mixing and mastering. 
 

1. Multitrack audio is recorded in Pro Tools while the chasing the event master time code.  
2. A mono or stereo mix is recorded simultaneously as a guide track for use by the video editor. 
3. The picture and audio guide tracks are edited in a video editing application (such as Avid Media 

Composer) to produce a modified timeline for repurposing, such as fitting broadcast time 
requirements, web repurposing, etc. 

4. The edited audio guide tracks are exported from the video editor’s sequence as an AAF (or OMF) 
sequence. Include handles of at least 2 frames to compensate for frame vs sample accurate 
timestamps between applications. 

5. The AAF (or OMF) sequence is imported into Pro Tools as a new session. 
6. The original source audio files and unedited guide track are also imported into the session. 
7. The original unedited guide track is relinked to the session  
8. The Pro Tools editor Right-clicks the name of the guide track and selects Expand to New Tracks 

By Time Code Only. The original source tracks expand to new tracks with edits and fades that 
match the guide track. 

 

 

9.24 Relinking the Original Unedited Guide Track: 
 
After importing the AAF (or OMF) sequence and original source audio files into the session, you can 
relink the edited guide track to the original unedited source audio. To relink the original unedited guide 
track: 
 

1. Open the Project Browser for the session and open the Audio Files folder. 
2. Right-click the edited guide track audio file in the browser and choose Relink Selected. 
3.  In the upper pane of the Relink window, navigate to the original unedited guide track audio file 

that was recorded in Pro Tools. 
4. In the Select Files To Relink pane, select the edited guide track file. 
5. Drag the original unedited guide track audio file into the Candidates pane. If a dialog appears 

stating that one or more files are shorter than the media file you are trying to relink, click Yes to 
select it for relinking anyway. 

6. Check the box to the left of the file in the Candidates pane so that the Link icon appears. 
7. Click Commit Links at the top of the Relink window and then close the Relink window. 

 
You can now Right-click the name of the guide and select Expand To New Tracks > By Time Code Only. 
All expanded tracks should be synchronous with the guide track. 
 
 

 
 
 
 
 
 
 
 
 


